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Abstract. The article highlights the possibilities of using interdisciplinary integration by 

teachers of higher education institutions in preparing students for future professional activities, 

and describes interdisciplinary integration as a process of harmonizing curricula in the context of 

unified, continuous and comprehensive development of professional activities. The main part of 

our article briefly describes the practical significance of the subject "Econometrics" in the 

preparation of bachelors of economic sciences for future professional activity, which allows to 

reasonably forecast the economic development of enterprises, study the existing risks and use them 

to evaluate management decisions. It is also noted the possibility of training students through the 

introduction of decision-making processes in the conditions of modernization of enterprises, 

analysis of their economic performance and effective use of econometric methods and models, 

including modern information technologies, in solving practical problems in this area. The article 

presents a variety of software products for solving econometric problems using information 

technologies, including: spreadsheets (MS Excel, OpenOffice.org Calc), statistical software 

packages (SPSS, STATISTISA, STATGRAPHICS), programs specialized in solving econometric 

problems (Econometric Views, STADIA, Matrixer 3.4), mathematical packages (Mathcad, Matlab, 

Maple, Mathematica) and others.  

Keywords: interdisciplinary integration, information technology, econometrics, methods 

of statistical analysis of correlation and regression, MS Excel spreadsheet, library of functions, 
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1. Introduction 

In modern society, the level of development of a country is determined not only by the state 

of its economic potential, but also by the professional qualifications of specialists trained in higher 

educational institutions. The modern labor market places high demands on the qualifications and 

professional training of future specialists, and this in turn leads to increased competition among 

graduates. It is known that today, with the rapid development of science and technology, the 

volume of many scientific knowledge, concepts and ideas is growing rapidly. . This, on the one 

hand, ensures its differentiation with the formation of new industries and areas of science and 

technology, and on the other hand, breaks the prevailing boundaries between sciences and creates 

a process of integration. 

Integration (Latin: Integratio - “restore”, “replenish”, “connect”) refers to the process of 

merging parts into one whole. Interdisciplinary integration is considered as a process of mutual 

coordination of curricula in the conditions of a unified, continuous and comprehensive 

development of professional activity, and interdisciplinary integration in terms of skills formation 

becomes the logical basis for the self-development of a future specialist. 
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      Interdisciplinary integration in the modern understanding is the linking of all components 

of the educational process of a logical direction (goals, results, content, forms and methods of 

teaching). It is also characterized by the content and technological connection of disciplines, 

current scientific and practical problems between the content and technology of professional 

activity of future specialists [1]. 

The education and training of students, their preparation for conscious engagement in their 

chosen profession by teachers, as well as how to organize the educational process for creativity 

and work are influenced by curricula, classroom resources, technical and methodological support, 

etc. At the same time, the learning process will be effective if it stimulates students’ desire to 

obtain specific active knowledge and arouses their desire. 

The educational material is a pedagogically correct and understandable system of 

knowledge, fully assimilated by students, with a clearly defined goal. The content of any subject, 

taking into account standard programs and standards of professional education taught in higher 

education, should determine the following principles and requirements: 

coordination of the current state and prospects for the development of science, technology 

and technological processes in relevant sectors; 

correct construction of the educational process in the development of education and 

training of qualified specialists; 

implementation of the principles of general and professional didactics, which is the 

scientific and technical basis of science as a whole; 

the presence of components that develop the technical thinking of students and contribute 

to the formation of the potential of future specialists in accordance with their chosen profession, 

etc. 

In turn, professional didactics includes the following principles: 

demonstrativeness, systematization and continuity of knowledge, accessibility and 

expediency, conscious and active participation in the learning process, the strength of students’ 

knowledge, the connection of theory with practice, the connection of learning with life, scientific 

teaching, the effectiveness of students’ [2]. 

The subject program “Information complexes and technologies in economics” in the field 

of education 5230900-Accounting and Auditing (by industry) was approved in 2020 jointly with 

the Ministry of Higher and Secondary Specialized Education of the Republic of Uzbekistan and 

the Tashkent Financial Institute. Based on the approved scientific curriculum, teachers emphasize 

the need for students to use information and communication technologies (ICT) in solving 

economic problems, using them to develop analysis, decision-making, knowledge, skills and 

abilities for practical application. economics knowledge, etc. [3]. 

Also in the scientific program “Econometrics”, approved by the above organizations in 

2020, professors and teachers are shown how to teach 3rd year students in this direction the 

modernization of the economics of enterprises, the introduction of decision-making processes, 

training in the effective use of econometric methods and models, as well as modern information 

technologies in analysis their economic activities [4]. 

In this article, based on the above, we will focus on the relevance of the use of 

interdisciplinary integration by professors and teachers of higher education in preparing students 

for future professional activities. 

In the scientific article “Systematic review of interdisciplinary teaching and learning in 

higher education” by Elisabeth J.H. Spelt and other foreign scientists, they focused on the low 
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      level of interdisciplinary thinking in the subjects taught to students, on the factors motivating the 

acquisition of knowledge from two or more disciplines, their integration and development of 

logical thinking [5]. In his article "Interdisciplinary Trends in Higher Education," W. James Jacob 

noted that economics is built on modern knowledge and requires a skilled workforce and 

leadership to help meet the many challenges and needs that governments and societies face today. 

The author also emphasizes that higher education institutions cannot teach graduates to solve all 

current and emerging problems using a single educational source, and that interdisciplinary 

approaches are an important basis for meeting the urgent needs of university students today [6]. 

In their article “Factors of interdisciplinary integration in improving the quality of 

professional and pedagogical training of higher school students,” Russian scientists 

B.N.Tokurenova and others examined the problem of interdisciplinary integration in the process 

of professional and pedagogical training of masters. This study also reveals the importance and 

significance of interdisciplinary integration as a single, unifying principle that promotes systematic 

thinking of students, ensuring the creation of new, integrated content, as well as the readiness and 

ability of graduates to implement professional competencies in solving interdisciplinary scientific 

problems. and practical problems [7]. 

G.V. Rylova’s article “Interdisciplinary integration as a tool for improving the quality of 

training of future specialists” discusses methods and forms of organizing the educational process 

as one of the factors for improving the quality of training of future specialists, mechanisms of 

interdisciplinary integration, modular training technology [8]. 

Among the scientists of Uzbekistan, in the first chapter of M.H. Lutfullaev’s doctoral 

dissertation on the topic “Theory and practice of integrating information technologies in improving 

the educational process in higher education (using the example of computer science and natural 

sciences),” the theoretical and practical aspects of improving the process are considered. They 

were designed. This chapter also develops the pedagogical and psychological aspects of creating 

electronic aids, which are presented in relation to a traditional textbook, presentation of 

educational materials, their search, quick change of information, etc. [9]. 

The second chapter of D.O. Himmataliev’s doctoral dissertation on the topic “Integration 

of pedagogical and technical knowledge in the diagnosis of professional training (using the 

example of “Vocational education” in higher education)” entitled “Mechanisms for the integration 

of pedagogical and technical knowledge in diagnostics” covers the issues of professional training, 

issues of integration in technical higher education, integration of pedagogical and psychological 

theoretical and practical knowledge, interdisciplinary integration, integration of pedagogical and 

technical knowledge in the diagnosis of professional training and improving the competence of 

students [10]. 

2.Materials and methods 

In preparation for the future professional activity of bachelors in the field of economics, 

students are expected to study the subject “Econometrics” or its individual sections as part of the 

main curriculum. The practical significance of the science of econometrics is that it evaluates the 

economic consequences of management decisions, allowing one to quantify the existing 

connections between events, make a reasonable forecast of economic development in a given 

situation, study existing risks and give their quantitative assessment. Econometric analysis 

provides the basis for economic analysis and forecasting and enables economic decision-making. 

The objectives of econometrics are to teach students the effective use of econometric methods and 

models, as well as modern information technologies in the implementation of decision-making 
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      processes in the field of modernization of the economy of enterprises of different forms of 

ownership, analysis of their economic activities. and solving practical problems in this area.  

Econometrics is a science in which, based on economic theory and real statistics, 

mathematical models of mass economic phenomena are built to quantify or refute certain 

economic assumptions and predict relevant economic indicators. Thus, the object of study of 

econometrics is real economic processes, the subject of which are the quantitative properties of 

relations in the economy. 

Using the capabilities of modern computing technologies, today's computer software 

systems make it possible to organize tasks of statistical data processing, correlation and regression 

analysis, modeling and forecasting at a high quality level. 

Correlation is a method of statistical analysis that allows us to determine whether a 

relationship exists or does not exist between variables and its strength. 

Regression is a method of statistical analysis used to describe the nature of the relationship 

between variables (direct or inverse, linear or nonlinear). 

3. Results.  

Many software products exist to solve econometric problems using information 

technology. These include: spreadsheets (MS Excel, OpenOffice.org Calc, etc.), general statistical 

software packages (SPSS, STATISTISA, STATGRAPHICS, etc.), programs specializing in 

solving econometric problems (Econometric Views, STADIA, Matrixer 3.4, etc.), general purpose 

mathematical packages (Mathcad, Matlab [11], Maple, Mathematica, etc.). 

The Microsoft Excel spreadsheet is one of the most effective and convenient means of 

digital processing of econometric data, which is effective at the stage of teaching econometrics. 

This software product has the advantages of having methodological assistance in solving 

econometric problems, wide popularity, flexibility with many statistical software packages, the 

ability to perform calculations using a large number of mathematical and statistical functions, 

calculation of the distribution of random variables and many other advantages. Practical classes in 

econometrics are conducted in computer laboratories, and this process ensures that students 

complete laboratory work. Laboratory work should include professionally oriented tasks, the 

solution of which should regularly introduce the content of the econometrics course and ensure its 

successful completion, demonstrate to students the importance of econometrics in their future 

professional activities and interdisciplinary integration. 

Problem. Based on the statistics of Table 1, consider the dependence of annual revenue 

(variable y, million soums), given for twelve transport enterprises, on the average annual number 

of trucks (variable x). 

Table 1. Statistics obtained from transport companies 

𝑛 1 2 3 4 5 6 7 8 9 10 11 12 

𝑥 15 18 22 25 27 31 34 37 40 45 48 48 

𝑦 235 250 247 260 287 262 307 280 357 410 389 311 

Solving. This problem using statistical analysis methods of correlation and regression using 

an MS Excel spreadsheet and carry out the forecasting process. 

We check, based on the source data, whether there is a relationship between the variables 

in this problem.  

Table 2. Calculation of values corresponding to the problem 
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To do this, first of all, using a MS Excel table, we display the following values in 

accordance with table 1. 

The correlation coefficient is checked at the following time intervals: 

change interval -1 and 1; 

Close to -1, strong negative linear correlation; 

Close to +1, strong positive linear correlation; 

Near 0 there is a weak linear relationship. 

The formula for calculating the correlation coefficient is as follows: 

𝑅 =
𝑛 ∑ 𝑥𝑦 − ∑ 𝑥 ∗ ∑ 𝑦

√(𝑛 ∗ ∑ 𝑥2 − (∑ 𝑥)2) ∗ (𝑛 ∗ ∑ 𝑦2 − (∑ 𝑦)2)
           (1) 

 

𝑅 =
12 ∗ (122958) − (390) ∗ (3590)

√[12 ∗ (14106) − (390)2] ∗ [12 ∗ (1113587) − (3590)2]
= 0,846 

Let's consider two different ways to automatically calculate the solution to the above 

problem. For this we use the 𝑓𝑥 function library of the MS Excel spreadsheet. 

The Function Library is a standard set of functions in the Insert Function of an MS Excel 

spreadsheet. In it, functions are sorted by fields and activated using the 𝑓𝑥-key on the toolbar [13]. 

Method 1: In the first method, we use the CORE square root function. In cell A16 enter R=, in cell 

B16 enter =(12*F14-B14*C14)/SQRT((12*D14-B14^2)*(12*E14-C14^2)) and press ENTER to 

get result. 

Method 2. In the second method, we use the CORREL function from the 𝑓𝑥 category - 

Function Library → “Statistical”. Then enter R = in cell A17, =CORREL(B2: B13, C2: C13) in 

cell B17 and press ENTER to get the result. We can see that the results are the same in both cases. 

To check the result at a confidence level of 𝛼 = 0,05, use the following formula: 
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𝑡 =

𝑅

√1 − 𝑅2

𝑛 − 2

              𝑡 =
0,846

√1 − 0,716
12 − 2

= 5,015 

Here (n – 2 degrees of freedom). Based on the t-test statistics, we can conclude that there 

is a strong positive correlation between,  𝑅 = 0,846 → 𝑥 𝑎𝑛𝑑 𝑦 [14]. 

In the next step, we build a linear pairwise regression model, corresponding to the regression 

statistical analysis method, to describe the nature of the relationship between the variables. Its 

parameters are estimated using the ordinary least squares method. Its formula is as follows: 

𝑌 = 𝑏𝑋 + 𝑎                  (3)      

To determine the coefficients of the regression equation, we use the following formulas: 

𝑎 =
∑ 𝑦 ∗ ∑ 𝑥2 − ∑ 𝑥 ∗ ∑ 𝑥𝑦

𝑛 ∗ ∑ 𝑥2 − ∑ 𝑥 ∗ ∑ 𝑥
    𝑎 =

3595 ∗ 14106 − 390 ∗ 122958

12 ∗ 14106 − 390 ∗ 390
= 160,58 

𝑏 =
𝑛 ∗ ∑ 𝑥𝑦 − ∑ 𝑥 ∗ ∑ 𝑦

𝑛 ∗ ∑ 𝑥2 − ∑ 𝑥 ∗ ∑ 𝑥
           𝑏 =

12 ∗ 122958 − 390 ∗ 3595

12 ∗ 14106 − 390 ∗ 390
= 4,2771 

Based on the above formulas, you can derive the values of 𝑎 and 𝑏 using an MS Excel 

spreadsheet. Also, for a complete regression analysis of the problem in a MS Excel table, you must 

first enter the “Data Analysis” - Data Analysis item. To do this, in the MS Excel table, select “File” 

→ “Options” → “Add-ins” → “Management” → “Excel Add-ins”, use the “Go…” button to select 

“Analysis package” and press OK. After this, in the “Data” menu section, the data analysis 

(information) item “Data Analysis” will be created. Using this point, questions can be analyzed 

using a number of methods. One of them is this method of regression analysis. Below we will look 

at regression analysis of this problem. The data analysis item “Data Analysis” is launched and 

“Regression” is selected, in the range from “Input interval Y:” to the table (C2:C13) and in 

accordance with “Input interval X:” (B2:B13), the specified numbers are entered from using the 

mouse. In accordance with the “Output parameters” item, specify the output location and click 

OK. After this, the results of regression statistical analysis of this task are displayed. 

4. Discussion 

Another method for speeding up the solution of a particular problem using an MS Excel 

spreadsheet is to create a trend line on this scatter plot. A trend line in an MS Excel spreadsheet is 

a graph of the approximate forecasting function based on the statistics provided. This approximate 

prediction helps determine the outcome by increasing the number of x and y values to plot the 

function [14]. To solve the problem using a trend line in a scatter plot, the following work is carried 

out; 

1. Use the mouse to select the range from B2: C13; 

2. In the “Insert” menu section, select “Diagrams” → “Scatter” → “Scatter with straight 

lines and markers”; 

3. On the resulting chart, right-click on any point, select the “Add trend line..” command 

and select “Show equation on chart” to create the following chart (Figure 1) 

Thus, the regression equation coefficients corresponding to the least squares equation were 

determined using an MS Excel spreadsheet, and their values were: 𝑎 = 160,6; 𝑏 = 4,277. The 

regression equation has statistical significance at 𝛼 = 0,05: observed F-statistic value is 25,15; 

The critical value of Fisher's test is 4,96; the detection coefficient is 0,716. The value of coefficient 

𝑏 of the regression equation shows that an increase in the number of cars by one leads to an average 

annual increase of 4,277 million soums. 
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Figure 1. Description of this problem using a trend line 

5.Conclusions 

1. Due to the rapid development of industry and the economy, the changing worldview of 

people and the need for innovation, every year new disciplines appear in the process of higher 

education aimed at solving professional problems. When there is a need for such special disciplines 

as “Digital Economy”, “Investment Project Management”, “Enterprise Economics and Innovation 

Management” and others, it is difficult to find interdisciplinary connections with other cyclical 

disciplines [15]. 

2. With the regular use of integrated tasks performed in practical and laboratory classes 

when teaching students, professional activities carried out through interdisciplinary integration 

allow us to deepen the assimilation of acquired knowledge [16]. 

3. A graduate who has perfectly mastered professional skills will be able to successfully 

compete in the labor market and achieve creative thinking in solving problems related to 

professional activities. 

Advanced experts will agree that interdisciplinary integration must be introduced into the 

educational process of higher education using interactive pedagogical methods, hardware and 

software when preparing students for professional activities [17]. 

4. In improving the quality of education and preparing students for professional activities, 

the use of interdisciplinary integration leads to effective results [18]. 
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